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10. Trendlines and other drawing tools

TradingExpert provides tools for drawing and editing trendlines and
placing arrows and text on charts.  Other drawing tools allow you to
define Fibonacci Studies, Gann Fans, and Regression lines.  To access
the drawing tools while working in Charts, choose the Draw
command on the menu bar.  You can also access individual drawing
tool icons by clicking the View menu bar command, then clicking on
Drawing Tools to display a toolbar.

Drawing tools include:

� Cursor (used for editing trendlines, text, and arrows)

� Trendlines (for drawing trendlines)

� Up/Down Arrows (for placing arrows on charts)

� Text (T) (for entering notes on charts)

� Fibonacci Arcs

� Fibonacci Fans

� Fibonacci Retracements

� Fibonacci Time Zones

� Gann Fans

� Regression Lines

Drawing Tools toolbar buttons

Text insertion tool

Fibonacci Studies
drawing tools

Up/Down Arrow drawing tools

Arcs

Gann Fans drawing tool

Regression lines drawing tool

Retracements

Time Zones

Note
To view or hide the drawing
tools toolbar, click View on
the menu bar and from the
menu select (or deselect)
Drawing Tools.

Fans

Select items (normal cursor)

Trendline drawing tool
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Drawing, editing trendlines

The use of trendlines in technical analysis is as old as technical
analysis itself.  With AIQ TradingExpert Pro, trendlines can be used
for signal confirmation, to determine variable stop loss points, and to
help identify trading patterns in the tradition of classical technical
analysis.  TradingExpert Pro allows you to draw unlimited trendlines
on Price Plots and technical indicator plots.

To create new trendlines

å To draw trendlines on a Price Plot or on an indicator plot:

1. Click the Trendlines icon on the toolbar.  Or, select the Draw
command on the menu bar, then choose Trendlines from the drop-
down menu.

2. The trendline drawing cursor appears.  Note, the exact coordinates of
the cursor appear at the top right of the Chart window.

3. Position the cursor at the point the trendline is to begin.

4. Click and hold down the left mouse button, guide the mouse to the
end point of the trendline, then release the mouse button.

5. When you have finished drawing your trendline(s), cancel the
trendline cursor by clicking the Trendlines button on the toolbar.
Clicking the Arrow button (located to the left of the Trendlines
button) will also cancel trendline drawing.

To edit an existing trendline

å You can edit a trendline in one of three ways:

1. Use the mouse to physically relocate the trendline on the chart.

Use the arrow cursor to select the trendline that you want to edit by
clicking anywhere on it with the left mouse button.  Three small
black dots will appear on the selected trendline, one at each end and
one at the midpoint.  Follow the directions below to edit (relocate)
the trendline.

� Move one end to a new location by first placing the cursor at
the end that you want to move.  The mouse pointer will
change to a double ended arrow.  Continue to hold down the
left mouse button while moving the end of the trendline to its
new location.  Release the mouse button.

Trendline drawing  cursor
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� Move the entire trendline to a new location by clicking on the
trendline until the mouse pointer changes to a four-pronged
arrow.  Continue to hold down the left mouse button while
moving the trendline to its new location.  Release the mouse
button.

2. Use the Properties function on the right-click menu to enter new end
point coordinates for the trendline.

� With the right mouse button click anywhere on the trendline
that you wish to edit.  This will both select the trendline and
display the Trendline Edit menu.

� Select Individual Properties from this menu.  A dialog box
titled Trendline Properties is displayed.

Trendline Properties dialog box

Chart with Trendline Edit menu
displayed
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� The dialog box lists the Start and End price and date
coordinates for the trendline.  To adjust the trendline, enter
revised coordinates.

� Click OK.

3. Use the Edit command on the Draw menu to enter new end point
coordinates for the trendline.

� Click Draw on the menu bar, then Edit on the sub-menu.
The Edit Attributes dialog box that appears lists all trendlines
and other items that have been drawn on the displayed chart.

� Select the trendline that you want to edit and click the Edit
command at the bottom.

� The next dialog box, Trendline Properties, lists the Start and
End price and date coordinates for the trendline.  To adjust
the trendline, enter revised coordinates.

� Click OK to return to Edit Attributes and click OK again.

Trendline Properties dialog box

Edit Attributes for Ticker INTC
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Trendline Preferences dialog box

Note
The Edit command on the
Draw sub-menu may also be
used to delete a trendline.  In
the Edit Attributes dialog box,
select the trendline you want
to delete and click Delete.

Trendline right-click Edit menu

To delete a trendline

å To delete a trendline:

� With the right mouse button click anywhere on the trendline that you
wish to delete.  This will both select the trendline (three small black
dots will appear on the trendline) and the Trendline Edit menu will
appear.

� Select Delete from this menu.  The selected trendline will be
removed from the chart.

To extend a trendline

å To extend a trendline to end of chart:

� With the right mouse button click anywhere on the trendline that you
wish to extend.  This will both select the trendline (three small black
dots will appear on the trendline) and the Trendline Edit menu will
appear.

� Select Extend from this menu.  The selected trendline will be
extended from its far right endpoint until it reaches the end of the
chart.

å To extend a trendline automatically after each update:

� With the right mouse button click anywhere on the trendline that you
wish to extend.  This will both select the trendline (three small black
dots will appear on the trendline) and the Trendline Edit menu will
appear.

� Select Global Preferences from this menu.  The Trendline
Preferences dialog box will appear.

� Click the option to automatically extend trendlines on the Price Plot
or on the Indicator Plot, or both.

� As long as the trendline remains on the chart, it will be automatically
extended with each update of the chart data.
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Note
The Edit command on the
Draw sub-menu may also be
used to edit or delete items on
a chart.

To add Up/Down Arrows

Use this function to mark specific events, etc. on a chart with arrows.

å To place an up or down arrow on a chart:

1. Click on either the up Ý or down ß arrow icon on the toolbar.  Or,
choose the Draw command on the menu bar and from the drop-
down menu choose Up Arrows or Down Arrows.   The mouse
pointer changes to a cursor with a small black arrow.

2. Move the cursor to the location where you want to add the arrow.
Click the left mouse button.

3. To cancel the Arrow drawing cursor and return to the normal arrow
cursor, press the Arrow on the toolbar (to the left of the Trendlines
toolbar button).

å To delete an arrow from a chart:

1. Position the mouse cursor over the arrow and click the right mouse
button to display a menu.

2. Click the Delete command to delete the arrow.

To add Text

Use this function to add text notations directly on charts.

å To place a block of text anywhere on a chart:

1. Click on the Draw Text toolbar icon (T).  Or, choose the Draw
command on the menu bar and from the drop-down menu choose
Text.  The mouse pointer changes to a vertical text cursor.

2. Move the cursor to the location where you want to add the note and
click the left mouse button.

3. Type a note.

4. To cancel the Text cursor and return to the normal arrow cursor,
press the Arrow on the toolbar (to the left of the Trendlines toolbar
button).

å To delete or edit text:

1. Position the mouse cursor over the text and click the right mouse
button to display the menu.

2. Click the Delete command to delete the text, or select the Properties
command to edit the text.

Note
To view or hide the drawing
tools toolbar, click View on
the menu bar and from the
menu select (or deselect)
Drawing Tools.
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Fibonacci Studies

Fibonacci numbers are a sequence of numbers in which each
successive number is the sum of the two previous numbers: 1, 1, 2, 3,
5, 8, 13, 21, 34, 55, 89, 144, 233, 377, 610, etc.  These numbers
possess an intriguing number of interrelationships, such as the fact that
any given number is approximately 1.618 times the preceding number
and any given number is approximately 0.618 times the following
number. This numerical relationship is named for its discoverer,
Leonardo Fibonacci, who was an important mathematician born in
Italy around the year 1170.  It is rumored that Fibonacci found this
relationship while studying the Great Pyramid of Giza in Egypt.

There are four Fibonacci Studies used to analyze chart patterns:  Arcs,
Fans, Retracements, and Time Zones.  The general interpretation of
the Fibonacci Studies involves the anticipation of a change in trend as
prices near the lines created by the studies.

Fibonacci Arcs

Fibonacci Arcs are constructed by first drawing a trendline between
two extreme points on a chart; for example, a trough and the opposing
peak.  Three arcs are then drawn, centered about the second extreme
point.  The radiuses of these arcs represent distances along the
trendline proportional to its length and are equivalent to the Fibonacci
levels of 38.2%, 50.0%, and 61.8%.

The interpretation of Fibonacci Arcs involves anticipating support and
resistance as prices approach the arcs. The chart on the preceding page
illustrates how the arcs can provide support and resistance.

A common technique is to display both Fibonacci Arcs and Fibonacci
Fan lines (see below) and to anticipate support/resistance at the points
where the Fibonacci Studies intersect.

Note that, because the Arcs are drawn so they are circular relative to
the chart axis, the points where the Arcs cross the price data will vary
depending on the scaling of the chart.
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å To draw a Fibonacci Arc on a chart:

1. Display a chart of the ticker you want to analyze.

2. From the Draw sub-menu select Fibonacci Arcs, or click the
Fibonacci Arcs toolbar button.  The arrow cursor will change to the
Fibonacci Arcs drawing cursor.

3. Place the cursor at the point on the price chart where you would like
the trendline to begin and press the left mouse button.

4. While continuing to hold down the button, move the cursor to the
point where you want the trendline to end.

5. When you release the mouse button, the Fibonacci Arc study will be
automatically drawn.

6. To cancel the Fibonacci Arc drawing cursor and return to the normal
arrow cursor, press the Arrow on the toolbar (to the left of the
Trendlines toolbar button).
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Fibonacci Fans

Fibonacci Fans are displayed by drawing a trendline between two
extreme points; for example, a trough and the opposing peak.  Then an
�invisible� vertical line is drawn through the second extreme point.
Three trendlines are then drawn from the first extreme point so they
pass through the invisible vertical line at the Fibonacci levels of
38.2%, 50.0%, and 61.8%.  (This technique is similar to Speed
Resistance Lines.)   The chart below shows how prices find support at
the Fan lines.

You can see that when prices encountered the top Fan line (point
�A�), they were unable to penetrate the line for several days.  When
prices did penetrate this line, they dropped quickly to the bottom Fan
line (points �B� and �C�) before finding support.  Also note that when
prices bounced off the bottom line (point �C�), they rose freely to the
top line (point �D�) where they again met resistance, fell to the middle
line (point �E�) and rebounded.

å To draw Fibonacci Fan lines on a chart:

1. Display a chart of the ticker you want to analyze.

2. From the Draw sub-menu select Fibonacci Fans, or click the
Fibonacci Fans toolbar button.  The arrow cursor will change to the
Fibonacci Fans drawing cursor.
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3. Place the cursor at the point on the price chart where you would like
the trendline to begin and press the left mouse button.

4. While continuing to hold down the mouse button, move the cursor to
the point that you want the trendline to end.

5. When you release the mouse button, a trendline will be drawn
between the two points and three Fibonacci Fan lines (shown as
dashed lines) will be automatically drawn below the trendline.

6. To cancel the Fibonacci Fans drawing cursor and return to the
normal arrow cursor, press the Arrow on the toolbar (to the left of
the Trendlines toolbar button).

Fibonacci Retracements

Fibonacci Retracements are constructed by first drawing a trendline
between two extreme points; for example, a trough and the opposing
peak.  A series of nine horizontal retracement lines are then drawn
intersecting the trendline at the Fibonacci levels of 0.0%, 23.6%,
38.2%, 50%, 61.8%, 100%, 161.8%, 261.8%, and 423.6%.  The
values are percentages of the total length of the trendline.  Obviously,
values greater than 100% will fall below (or above) the starting point
of the trendline.  Some of the lines will probably not be visible
because they will be off the scale.

Note:
For instructions on how to
edit a Fibonacci Study, go to
the end of this section.
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After a significant price move (either up or down), prices will often
retrace a significant portion (if not all) of the original move.  As prices
retrace, support and resistance levels often occur at or near the
Fibonacci Retracement levels.  In the  chart below, Fibonacci
Retracement lines were drawn between a major trough and peak.

You can see that support and resistance occurred near the Fibonacci
levels of 23% and 38%.

å To draw Fibonacci Retracement lines on a chart:

1. Display a chart of the ticker you want to analyze.

2. Click the Draw command on the menu bar and from the drop-down
menu select Fibonacci Retracements, or click the Fibonacci
Retracements toolbar button.  The arrow cursor will change to the
Fibonacci Retracements drawing cursor.

3. Place the cursor at the point on the price chart where you would like
the retracement trendline to begin and press the left mouse button.

4. While continuing to hold down the mouse button, move the cursor to
the point that you want the trendline to end.

5. When you release the mouse button, a trendline will be drawn
between the two points and the Fibonacci Retracement lines (shown
as horizontal dashed lines) will be automatically drawn based on the
length and position of the trendline.

6. To cancel the Fibonacci Retracements drawing cursor and return to
the normal arrow cursor, press the Arrow on the toolbar (to the left
of the Trendlines toolbar button).

Fibonacci Time Zones

Fibonacci Time Zones are a series of vertical lines that are spaced at
the Fibonacci intervals of 1, 2, 3, 5, 8, 13, 21, 34, etc.  The first line is
placed at an extreme point on the chart and the lines that follow are
spaced at increasingly wider intervals in accord with the Fibonacci
sequence.  Interpretation of Fibonacci Time Zones involves looking
for significant changes in price at or near the vertical lines.

Time Zones are most applicable to a long-term analysis of price action
and are probably of limited value when studying short-term charts.
Users inexperienced with Fibonacci Studies should consider this type
of analysis only when viewing charts that span multiple years.  In the
example charted on the next page, Fibonacci Time Zones were drawn
on the Dow Jones Industrials beginning at the 1982 market bottom.
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On the chart, you can see that significant changes in the Dow occurred
on or near the Time Zone lines.

å To draw Fibonacci Time Zones on a chart:

1. Display a chart of the ticker you want to analyze.

2. From the Draw sub-menu, select Fibonacci Time Zones or click the
Fibonacci Time Zones toolbar button.  The arrow cursor will
change to the Fibonacci Time Zones drawing cursor.

3. Place the cursor at the point in time on the price chart where you
would like the Time Zone lines to originate and click the left mouse
button.

4. The Fibonacci Time Zone lines (shown as vertical dashed lines) will
be automatically drawn.  The first line is located at the specified
time.  Subsequent lines are drawn in sequence from left to right to
define the Fibonacci Time Zones.

5. To cancel the Fibonacci Time Zones drawing cursor and return to
the normal arrow cursor, press the Arrow on the toolbar (to the left
of the Trendlines toolbar button).
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To edit Fibonacci Studies

å To edit Fibonacci Arcs, Fans, and Retracement Lines:

Fibonacci Arcs, Fans, and Retracement Lines are edited by relocating
the trendline on which the study is based.

1. Relocate the study trendline.  (See instructions on how to edit a
regular trendline earlier in this section.)

2. Based on the trendline's new location, the study will be
automatically redrawn.

å To edit a Fibonacci Time Zone study:

Fibonacci Time Zones are edited by simply changing the date when
the study begins.  You can do this in one of three ways.

1. Use the mouse to physically relocate the study on the chart.

� Use the arrow cursor to select the left most (solid) Time Zone
of the study that you want to edit by clicking anywhere on it
with the left mouse button.  Three small black dots will
appear on the selected trendline, one at each end and one at
the midpoint.

� To edit (relocate) the trendline, move the arrow cursor over
the selected line until the mouse pointer changes to a double
ended arrow.  Hold down the left mouse button while moving
the trendline to its new location.

� When you release the mouse button, the study will be
automatically redrawn.

2. Use the Properties function on the right-click menu to enter a new
date for the Time Zone study.

� With the right mouse button click on the first (solid) vertical
line.  This will both select the study and display a menu.

� Select Individual Properties from this menu.  A dialog box
titled Fibonacci Time Zone Properties is displayed.

� The dialog box displays the date for the study.  To adjust the
study, enter a revised date.

� Click OK and the study will be automatically redrawn.
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3. Use the Edit command on the Draw menu to enter a new date for the
study.

� Click Draw on the menu bar, then Edit on the sub-menu.
The Edit Attributes dialog box that appears lists all studies
and other items that have been drawn on the displayed chart.

� Select the Time Zone study that you want to edit and click
the Edit command at the bottom.

� The next dialog box, Fibonacci Time Zone Properties, lists
the date for the study.  To adjust the study, enter a revised
date.

� Click OK to return to Edit Attributes and click OK again and
the study will be automatically redrawn.
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To delete Fibonacci Studies

To delete any of the Fibonacci Studies, selecting the Delete command
from the right-click menu is the simplest approach.

å To delete a study using the right-click menu:

� With the right mouse button click anywhere on the study trendline.
For Fibonacci Time Zones, which are not based on a trendline, click
on a solid (not dashed) line.  This will both select the study (small
black dots will appear on the trendline or other component) and the
right-click menu will appear.

� Select Delete from this menu.  The selected study will be removed
from the chart.

Alternative method for deleting a study

å To delete a study from the Edit Attributes dialog box:

1. Click Draw on the menu bar, then Edit on the sub-menu.  The Edit
Attributes dialog box that appears lists all studies and other items
that have been drawn on the displayed chart.

2. Select the study that you want to delete and click the Delete
command at the bottom.

3. When the Edit Attributes dialog box reappears, the study will be
removed form the list of chart attributes.
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Gann Fans

W. D. Gann (1878-1955) designed several unique techniques for
studying price charts.  Central to Gann�s techniques is the use of
geometric angles in conjunction with time and price.  Gann believed
that specific geometric patterns and angles had unique characteristics
that could be used to predict price action.

Gann�s techniques require that charts be drawn with equal time and
price intervals, so that a rise/run of one price unit for each time unit
(called a 1 x 1 trendline or angle) will equal a 45 degree angle
anywhere on the chart.  Gann believed that the ideal balance between
time and price exists when prices rise or fall at a 45 degree angle
relative to the time axis.

Gann angles are drawn between a significant bottom and top (or vice
versa) at various angles.  Deemed the most important by Gann, the 1 x
1 trendline is used as a criteria for both bull and bear markets.  Gann
felt that a 1 x 1 trendline provides major support during an uptrend;
when the trendline is broken, it signifies a major reversal in the trend.
A bull market is signified if prices are rising and are above the upward
sloping 1 x 1 trendline.  Conversely, a bear market is indicated when
prices are falling and are below the downward sloping 1 x 1 trendline.



Chapter IV: Charts    243

Although the theory relies on certain exact chart angles (Gann
identified nine significant angles, with the 1 x 1 being the most
important), an exact price/time relationship is not specified.
Obviously, a 45 degree angle drawn on a chart is no longer 45 degrees
when the price or time scale is changed without a corresponding
change in the opposing scale.  Therefore, Gann Fans should be used
with caution, especially since the price scale on AIQ charts varies
from one chart to the next.  The technique is probably best suited to
longer term studies where major trends can be identified and the width
of the price scale is usually greatest.

In addition to the 1 x 1 angle, Gann specifies eight different angles,
four greater than 45 degrees and four less than 45 degrees, as lines of
significant support and resistance.  The AIQ Gann drawing tool
creates only two of these lines, the 1 x 2 (63.75 degrees) and the 2 x 1
(26.255 degrees) in addition to the 1 x 1 (45 degrees) line.  Gann
observed that each of these angles can provide support and resistance
depending on the trend.  According to Gann, when prices move below
the 1 x 1 angled trendline during an uptrend, prices should then be
expected to fall to the next trendline (i.e., the 2 x 1 angle).  In other
words, as one angle is penetrated, expect prices to move and
consolidate at the next angle.

To draw Gann Fans

å To draw a Gann Fan on a chart, do as follows:

1. Display a chart of the ticker you want to analyze.

2. Click the Draw command on the menu bar and from the drop-down
menu select Gann Fans.  The arrow cursor will change to the Gann
Fans drawing cursor.

3. Place the cursor at the point on the price chart where you would like
the Gann Fan to begin and press the left mouse button.  When you
release the mouse button, the Gann Properties dialog box will
appear.

4. The Vertex section of the Gann Properties dialog box lists the
coordinates of the point on the chart where the mouse was located
when you clicked the mouse.  This where the Gann Fan will
originate.  You can change these coordinates if you wish.
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5. The section titled 1x1 Price and Time Units displays two values, one
for each axis.  If you were to measure along each axis from the
lower left corner of the chart distances equal to these values and then
drew a line connecting these points, the resulting line should be a 45
degrees angle on the chart.  You can change these values if you
wish.

6. The section titled Trend displays two options.  If the trend of the
data you are studying is up, select Up. If the trend is down, select
Down.

7. When you are satisfied with the entries shown, click OK and the
Gann Fan study will be automatically drawn.

8. To cancel the Gann Fan drawing cursor and return to the normal
arrow cursor, press the Arrow on the toolbar (to the left of the
Trendlines toolbar button).

To edit Gann Fans

Gann Fans are edited by changing the price/date coordinate of the
point where the study begins.  The Gann Properties dialog box also
allows revision of the price and time units that define a 1x1 angle on
the chart.

å You can edit a Gann Fan in one of three ways:

1. Use the mouse to physically relocate the study on the chart.

� Use the arrow cursor to select the Gann Fan that you want to
edit by clicking anywhere on one of the three fan lines with
the left mouse button.  A small black square will appear at the
point where the three fan lines originate (vertex).
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� To edit (relocate) the fan, move the arrow cursor over the
vertex point and press the left mouse button.  Two lines
parallel to the two chart axis will appear.  The intersection of
these lines indicates the location of the Gann Fan vertex.
Hold down the left mouse button while moving the fan to its
new location.

� When you release the mouse button, the study will be
automatically redrawn.

2. Use the Properties function on the right-click menu to enter new
coordinates for the Gann Fan vertex.

� With the right mouse button, click on one of the fan lines.
This will both select the study and display a menu.

� Select Individual Properties from this menu.  A dialog box
titled Gann Properties is displayed.

� The dialog box displays the date for the study.  To adjust the
study, enter a revised date.

� Click OK and the study will be automatically redrawn.

3. Use the Edit command on the Draw menu to enter new coordinates
or new 1x1 price/time angle units for the study.

� Click Draw on the menu bar, then Edit on the sub-menu.
The Edit Attributes dialog box that appears lists all studies
and other items that have been drawn on the displayed chart.

� Select the Gann study that you want to edit and click the Edit
command at the bottom.

� The next dialog box, Gann Properties, lists the current fan
vertex coordinates and the 1x1 angle units for the study.  To
adjust any of the data for this study, enter revised
information.

� Click OK to return to Edit Attributes and click OK again.
Based on the revised information, the study will be
automatically redrawn.
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To delete Gann Fans

To delete a study, selecting the Delete command from the right-click
menu is the simplest approach.

å To delete a Gann Fan using the right-click menu:

� With the right mouse button, click anywhere on one of the Gann Fan
lines.  This will both select the study (small black dots will appear at
the fan vertex) and the right-click menu will appear.

� Select Delete from this menu.  The selected study will be removed
from the chart.

Alternative method for deleting a Gann Fan

å To delete a Gann Fan from the Edit Attributes dialog box:

1. Click Draw on the menu bar, then Edit on the sub-menu.  The Edit
Attributes dialog box that appears lists all studies and other items
that have been drawn on the displayed chart.

2. Select the Gann study that you want to delete and click the Delete
command at the bottom.

3. When the Edit Attributes dialog box reappears, the study will be
removed form the list of chart attributes.
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Regression Lines

Linear regression is a statistical procedure that is used to predict future
values from past values.  In the case of security prices, it is commonly
used to determine quantitatively the underlying trend and to project
future prices.

Simply put, a Linear Regression trendline is a straight line through a
series of data values that is drawn to represent an average of all the
values.  The least squares method is used to determine the line that
best fits the data.  In this method, the objective is to minimize the
distances between the resulting line and the data values.

If you had to guess what a particular security�s price would be
tomorrow, a logical guess would be �fairly close to today�s price.�  If
prices are trending up, a better guess might be �fairly close to today�s
price with an upward bias.�  Linear regression analysis is the statistical
confirmation of these logical assumptions.

When drawing a Regression trendline on a chart, the user specifies the
time interval which the trendline represents and the trendline is drawn
using only those data values that fall within this interval.  The
trendline, which is displayed in the exact middle of the price data
within the specified time interval, is always extended ahead in time to



248    AIQ TradingExpert Pro Reference Manual

the end of the chart.  This allows you to easily determine if more
recent price action is in line with or has deviated from a previously
established trend.

If you think of this trendline as the �equilibrium� price, the price
where buyers and sellers are in equilibrium, any move above or below
the trendline indicates overzealous buyers or sellers.  While prices
may deviate above or below the equilibrium level for short periods of
time, these excursions will only be temporary as long as the trend
remains in effect.  However, if prices remain significantly above or
below the established trend for a long period of time, a reversal in
trend may be imminent.

To create Regression Lines

å To draw a Regression trendline on a chart:

1. Display a chart of the ticker that you want to analyze with a
Regression trendline.

2. Click the Draw command on the menu bar and from the drop-down
menu select Regression.  The arrow cursor will change to the
Regression trendline drawing cursor.

3. Place the cursor at the point on the price chart where you would like
the trendline to begin and press the left mouse button.

4. While continuing to hold down the button, move the cursor to the
time period that you want the trendline to represent.

5. When you release the mouse button, a trendline will be
automatically drawn.  Although the line is extended all the way to
the right, the position of the line is computed only from the data
values lying between the two selected points.

6. To cancel the Regression drawing cursor and return to the normal
arrow cursor, press the Arrow on the toolbar (to the left of the
Trendlines toolbar button).
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To edit Regression Lines

Regression Lines cannot be edited with the mouse but can be edited
through the Individual Properties or Edit functions which allow you to
enter revised Start and End dates for the line.

å Edit a Regression Line in one of these two ways:

1. Use the Properties function on the right-click menu to enter new
start or end dates for the line.

� With the right mouse button click anywhere on the regression
line.  This will both select the study and display a menu.

� Select Individual Properties from this menu.  A dialog box
titled Regression Line is displayed. This dialog box displays
the Start and End dates for the study.

� To adjust the study, enter revised dates.

� Click OK and the line will be automatically redrawn.

2. Use the Edit command on the Draw menu to enter new start and/or
end dates for the line.

� Click Draw on the menu bar, then Edit on the sub-menu.
The Edit Attributes dialog box that appears lists all studies
and other items that have been drawn on the displayed chart.

� Select the Regression Line that you want to edit and click the
Edit command at the bottom.

� The next dialog box, Regression Line, lists the current Start
and End dates for the study.  To adjust the study, enter
revised dates.

� Click OK to return to Edit Attributes and click OK again.
Based on the revised information, the study will be
automatically redrawn.

To delete a Regression Line

To delete any type of study, selecting the Delete command from the
right-click menu is the simplest approach.

å To delete a Regression Line using the right-click menu:

� With the right mouse button click anywhere on the Regression Line.
This will both select the study (small black dots will appear on the
Regression Line) and the right-click menu will appear.

� Select Delete from this menu.  The selected study will be removed
from the chart.
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Alternative method for deleting a Regression Line

å Delete a Regression Line from the Edit Attributes dialog box:

1. Click Draw on the menu bar, then Edit on the sub-menu.  The Edit
Attributes dialog box that appears lists all studies and other items
that have been drawn on the displayed chart.

2. Select the Regression Line that you want to delete and click the
Delete command at the bottom.

3. When the Edit Attributes dialog box reappears, the Regression Line
will be removed form the list of chart attributes.
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11. Using the Explore feature

TradingExpert Pro�s Explore feature provides a quick and easy way of
looking at charts of tickers in your Group/Sector List or any of the
other lists that you have created.  The Explore feature provides
direction buttons that you can use to move from chart to chart in a
list.  With this feature, you are able to navigate through a group/
sector pyramid structure, moving easily from sectors to groups to
stocks.  Or, use Explore to quickly view charts of the equities and/or
mutual funds contained within a portfolio.

How to use Explore

å To use Explore, follow these basic steps:

1. While working in Charts, choose a list to explore by clicking the
arrow on the Explore List box on the toolbar, then clicking the
name of a list.

2. If  the Control Panel is in the indicator display mode, press the
Enter key to switch to the Explore window.

3. Click one of the tickers in the list in the Explore window to display
a chart.  (If you selected the S&P 500 list, click ZALL.)

4. Use one of the three methods described below to quickly move from
ticker to ticker in your selected list:

� Use the four Explore buttons on the toolbar.  You can move
to the right, to the left, up, or down.

� Click the Explore command on the menu bar and select one
of the four directions from the drop-down menu.

� Use keys to navigate:

+ to move right

-  to move left

* to move up

/  to move down.

Explore toolbar

Click this arrow to
display list namesExplore buttons

Note
When exploring a single-
level list, such as a portfolio
list where you can only move
to the right or to the left, the
navigation buttons or
commands that are not
available are dimmed.
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å To switch to another list to explore:

1. Click the arrow on the Explore List box on the toolbar, and select
another list.

2. A chart of the first ticker in the selected list is displayed and the list
appears in the Explore window.  (If  the Control Panel is in the
indicator display mode, press the Enter key to switch to the Explore
window.)

3. Use one of the methods described above to quickly move from ticker
to ticker in your selected list.

Example group/sector exploration

The S&P 500 industry group/sector structure is shown in the
illustration.  The structure, which is in the form of a pyramid, begins
with the individual stocks in the S&P 500 list.  These stocks form the
base of the pyramid.

The next higher level of the pyramid consists of the groups into
which the individual stocks have been combined.  These groups of
related stocks are then combined into industrial sectors and these
sectors make up the next level.

Finally, at the apex of the pyramid, the industrial sectors are
combined into a single index which AIQ calls the master sector (ZALL).

A navigation star is shown above the apex of the group/sector pyramid
in the illustration.  This star shows the four directions that you can
move within the pyramid, and the keys that are used for each direction.
As noted earlier, you can also use the toolbar buttons to navigate
through the group/sector structure.

Note
When exploring a list of
charts using TradingExpert
Pro�s Explore Feature and
you reach the beginning or
the end of a list, the left or
right Explore button will
�wrap around� (take you to
the opposite end of the list)
and continue to display charts
instead of dead-ending.
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 Group/sector pyramid

å To perform an example exploration, proceed as follows:

1. Begin with a chart of  the master sector, ZALL, displayed.  Notice
that the only direction you can move is down, and hence only the
down button on the toolbar is active.

2. Press the down button (or slash key) to display a chart of the first
industrial sector, the Automobile Sector.

3. Use the right button on the toolbar (or plus key) to display a chart of
the next sector listed, which is the Building Sector.

4. Use the down button (or slash key) to move down one level and
display a chart of the Building Materials Group (2949).

5. Using the right button (or plus key), you can move laterally and
quickly view charts of all groups in the Building Sector.

6. Use the down button (or slash key) once more to move down to the
lowest level, the individual stock level.  By continued use of the
plus key, you can easily view charts of all stocks in the group you
are exploring.
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12. Using the Tag List feature

The Tag List feature allows you to easily create a new list of tickers
while working within Charts.  Also, as you are working within
Charts, you may come upon a ticker that you want to include in one
of your existing lists.  Or, you may want to delete a ticker from an
existing list.  With this feature, you can add or delete tickers to lists
without leaving the Charts application.  Using the Explore and Tag
List features together gives you great flexibility in keeping your lists
current.

The Tag List feature allows you to:

� Create a new list of tickers.

� Add a ticker to an existing list.

� Delete a ticker from an existing list.

� Add a ticker to multiple lists.

How to create a new list

å To create a list while working within Charts, follow these
steps:

1. With a chart or charts displayed, click the TagList command on the
menu bar.

2. Choose Set TagList on the drop-down menu.  The Set Tag List
dialog box appears.

Set Tag List dialog box

3. Click the New command button.
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4. In the next dialog box , type the name of a new list in the text box and
choose OK.  The list name cannot include spaces or non-alphabetic
or numeric characters (i.e.,  /, \, *, etc.).

5. The name of your new list is displayed in the text box of the Set Tag
List dialog box.  Choose OK.  The new list becomes the current list
and its name appears in the status bar on the bottom of the chart.
Also, its name is added to the Explore List box on the toolbar.

6. You now can add tickers to this newly created list.

å To include tickers in a new list, proceed as follows:

1. Display a chart of the ticker that you want to include in the list by
selecting Chart Ticker from the Chart sub-menu.  Also, you can
display charts of tickers selected from an Explore List displayed in
the Explore window.

2. If more than one chart is displayed on your screen, activate (by
clicking) the chart of the ticker you want to include in your list.

3. Tag the ticker for inclusion in the new list in one of these two ways:

Click the Tag button on the toolbar.

� or �

Select the TagList command from the menu bar and choose Tag on
the drop-down menu.

4. When you tag a ticker, the Set Tag List dialog box appears with the
name of the current list displayed so that you can confirm that you
are placing the ticker in the correct list.  Choose OK to include the
ticker.

5. Continue the process to include other tickers in the list.

6. To keep track of tickers as you build the new list, display the list in
the Explore window by selecting its name from the Explore List box
on the toolbar.   (If the Control Panel is in the indicator display
mode, press the Enter key to switch to the Explore window.)

7. When you have completed the list, you now can use the Explore
feature to monitor it.

Note
A closed Tag button indicates
that the ticker is �untagged,�
not in the list.  An open Tag
button indicates that the
ticker is �tagged,� included in
the list.

Tip
When tagging multiple
tickers, you can bypass the
confirmation step by
removing the check mark
from the Confirm check box
on the Set Tag List dialog
box.  To remove the check
mark, simply click it.  The
dialog box will no longer
appear after each ticker is
tagged.
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How to add tickers to an existing list

å Follow these steps:

1. Display a chart of the ticker that you want to add to the list.

2. Click the TagList command on the menu bar.

3. Choose Set Tag List from the drop-down menu.  Click the arrow on
the Available Tag Lists text box, then click the name of the list you
want to add to.  The list must be a user list.  Tickers cannot be added
to a group list with this function.

4. Choose OK. The list becomes the current Tag List.

5. If more than one chart is displayed on your screen, activate the chart
of the ticker you want to add (highlight its title bar).

6. Click the Tag button on the toolbar (the button opens to indicate the
ticker is tagged), or select the TagList command from the menu bar
and choose Tag on the drop-down menu.

7. The Set Tag List dialog box appears with the name of the current
list displayed so that you can confirm that you are adding the ticker
to the correct list.  Choose OK to add the ticker.

8. Continue the process to add other tickers to the list.

How to remove tickers from an existing list

å Follow these steps:

1. Display a chart of the ticker that you want to remove from the list.

2. Click the TagList command on the menu bar.

3. Choose Set Tag List.  Click the arrow on the Available Tag Lists
text box, then click the name of the list you want to delete from.  The
list must be a user list.  Tickers cannot be removed from a group list
with this function.

4. Choose OK.  The list becomes the current Tag List.

5. Activate the chart of the ticker you want to delete (highlight its title
bar).

6. Click the Tag button on the toolbar (the button closes to indicate the
ticker is untagged), or  select the TagList command from the menu
bar and choose Untag on the drop-down menu.

7. Continue the process to remove other tickers from the list.

Tip
To keep track of tickers as
you add or delete from a list,
display the list in the Explore
window by selecting its name
from the Explore List box on
the toolbar.   (If the Control
Panel is in the indicator
display mode, press the Enter
key to switch to the Explore
window.)
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How to add a ticker to multiple lists

å Follow these steps:

1. Display a chart of the ticker.

2. Select the TagList command from the menu bar, then select Set Tag
List from the drop-down menu.

3. Choose the name of a list in the Available Tag Lists box.  Click OK.

4. Click the Tag button on the toolbar to add the ticker to the selected
list.

5. Click OK in the Set Tag List dialog box.

6. Continue the process by repeating steps 2 through 5.

Note
To delete a list, it is easiest to
go to Data Manager and use
the Delete function found on
the List sub-menu.
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13. Shortcut Keys for use in TradingExpert Pro charts

Action keys

A Toggle vertical date cursor line to a diamond and back
D Quick-change the date
G Toggle grid lines on or off
F Display fundamental information
W Toggle between daily and weekly data
M Toggle trendline drawing on or off
S Process a stock split or mutual fund distribution
T Add ticker to a tag list
U Untag ticker from tag list
O Overlay feature
R Refresh data for real-time charts
C Connect or disconnect for real-time charts
P Print active chart
L Toggle Log Scales on or off
V Set tag list
Z Toggle Zoom feature on or off

Function keys

F1 Help
F5 Close all open charts
F10 Toggle Control Panel on or off
Ctrl+O Display Chart Ticker dialog box
Esc Display Chart Ticker dialog box
Enter Toggle between Indicator and Explore panels
Ctrl+M Display Market Charts
Ctrl+Enter Display Indicator Constants box
Ctrl+left/right arrow Quick search for Expert Ratings
Alt+N Display ticker Notes
? Display ER rules
+ Explore right
- Explore left
* Explore up
/ Explore down
Left/right arrows Move date one period

Up/down arrows Select indicators or scroll through a list


